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What is EndNote?

e Bibliographic management software
* Online research tool

search online bibliographic databases and retrieve the references directly into EndNote

 Reference and image database

Storing, managing and search for bibliographic references in your private reference library

* Bibliographic and manuscript maker
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How Endnote works

EN
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Create bibliography A
C—

Report, Manuscript,
Thesis, etc.
Book, Journal, Research
Article, E-database, etc.
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How to download and install
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Software Download Centre

mm Microso
J Office

0= 85 @2 0= 02 MATLAB

1. http://softwaredownload.mahidol/

1 :
9 Staff Student
§ . g e
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How to download and install

Software Download

Software Download

Centre Centre

Home Microsoft Windows Application Antivirus Patch Update eHelpDesk.

2 2 | User Name 3
a

Password

. Mi «\
icrosoft et | T |

. dia
] Office .
3 afla MsaaaaTdsunsy
4 . Software Download
e n Offlce Fo:t u:mi;jﬂ:'mi‘hm
weR B el e e
I MATLAB dfia msanaaTilsunsy ’

aila Software Download
AnyDesk
fuddauiug Software Download @ Mahidol MATLAB Key Licensing

Hahaiwiems i IT tunimdvanaautiaa Windows 7 - 32 Bit

2. Log in by using Mahidol mail
3. Select Application
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How to download and install

Home  Microsoft Windows [aWdT=M Antivirus  Patch Update  eHelpDesk. Home  Microsoft Windows NEUdliLUl Antivius  Patch Update  eHelpDesk

Microsoft Office Standard 2011 for Mac
Microsoft Office Standard 2016 for Mac Hi Ticomporn Hi Ticomporn

- Luangwattanawilai,
Microsoft Office Standard 2015 for Mac Luangwattanawilai,

Microsoft Office Professional Plus 2010 - 32 Bit

Microsoft Office Professional Plus 2010 - 64 Bit

Microsoft Office Professional Plus 2013 - 32 Bit I

Microsoft Office Professional Plus 2013 - 64 Bit Q'fla

Microsoft Office Professional Plus 2016 - 32 Bit ! qﬁﬂ aila msandolusunsy
fAila Software Download

] Office

Microsoft Office Professional Plus 2016 - 64 Bit
Microsoft Office Professional Plus 2019 - 32 Bit
u ( Microsoft Office Professional Plus 2019 - 64 Bit
Proofing Tools 2016 - 32 Bit Multilanguage
Proofing Tools 2016 - 64 Bit Multilanguage

MATLA B Key Licensing
g n% | MATLAE R2020b for MAC o
Windows 8.1 - 32 Bit

MATLAB R2020b for Windows x64 ; Windows 8.1 - 64 Bit
MATLAB R2020b for Linux x64 kT LAB Key Licensing Windows 10 - 32 Bit
Windows 10 - 64 Bit
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AnyDesk
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AnyDesk
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File Size: 96.04 MB
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EndMote X9 for Mac
EndMote X9 for Windows
EndMote X20 for Mac
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How to download and install

”
ﬁ' EndNote X9 Setup

Select Installation

@ | have a product key

Thiz information can be found within your disc's packaging
ar in vour purchaze confirmation email.

EndNote*®

any time.

) | would like a 30-day free tnal

After 30 days zome functionality will become unavailable. An
expired trial wersion can be activated with a product key at

Purchaze a Product K.ey

£=4  Endnote_X9_for_Windows % Licensed EndMote X9
-_I}/ WinRAR ZIP archive : Text Document
=" 96.0 MB | 82 bytes

I8 Licensed EndNote X9 - Notepad

[ < Back ][ M et >

] [ Cancel
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Sle _Edit Format View Help
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Creating library folder

 Each Endnote library contain 1 library file (*.enl) and 1 data folder (keep the

attached PDF and picture files)

 Creating new library file in a folder and copy the whole folder if needed to

make sure that you do not loose anything.
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=) ) |
@-u-v| . €« 27, Brain death » Endnote library » b4 |4’r¢| | Search Endnote library o
Organize » Include in library « Share with + Burn New folder B il 7]
- Favorites I Brain death.Data m B death
i . EndMote Library
Bl Desktop i File folder BT .

& Downloads

7= Recent Places

. Libraries
3 Documents
rJ'- Music o e Ao .
& Pict | PDF 13/3/2563 %47 File folder
] ICTUres
B Videos J rdb 13/3/2563 9:47 File folder
| tdb 13/3/2563 9:47 File folder
1M Computer

&, Local Disk (¢ _

2 items
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File | Edit References Groups Tools Window Help

MNew...

Open Library...
Open Shared Library...
Open Recent

Close

“ Save
Save As...

Save a Copy..
Revert

Share...

Export...
Import

Print...
Print Preview

Print Setup...

Exit

EndNote : 7suns widesTausy (24/10/64)

Compressed Library (.enk] ...

Ctrl+O
Ctrtl+Shift+0

Ctrl+5

Ctrl+P

' @ New Reference Library

Creating library folder

52 » Libraries » Documents » w | %3 || Search Documents 0o
QO = ol |
Organize + Mew folder = - 9
't Favorites = Documents library Arangeby: Folder
Ml Desktop Includes: 2 locations
-
‘-i' Downloads Mame Date modified Type
(ﬂ Recent Places
|\ Custom Office Templates 2/9/2563 11:00 File foldel
& Libraries | | CyberLink 10,/9/2563 10:01 File foldei
Documente 1 | CyberLink 12/6/2557 6:33 File foldei
& Music | EndMote 16/9/2563 15:26 File foldel
& Pictures |\ EndNote 21/3/2561 8:55 File foldei
B Videos J! Zoom 4/9/2563 12:13 File foldel
18 Computer
£, Local Disk (C)
—a Local Disk (D:)
—u Seagate BackupF T ¢ | ! >
Ty EndNote Library| - |
Save as type: |EndMote Library (*.enl} v]
o .
& Hide Folders [ Save ] ’ Cancel ]

File > New... > create your library
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Group panel: shows you both default groups

and group sets that you create for your
research projects

@ EndNote X8 - [CAT]

Library overview

Tap panel: summary tab displays a detailed

overview of selected reference

|

Q, » £ Hide Search Panel

Reference

Preview :EPiipp-:u-@ L

&) %

¥

5 -
Rating

*hk - -
Author

Piippo, A
Miemeld, M.
van Popta, 1.
Kangasniemi, M.
Rinne, J.
Jadskeldinen, ). E.
Hernesniemi, J.

Year
2013

» .

m

Title ®
Characteristics and long-term outcome of 251
patients with dural arteriovenous fistulas in a
defined population

Journal
J Meurosurg

Volume
118

Issue

5

Pages
923-34
Start Page

Epub Date
2012/12/25

Date

@ File Edit References Groups Tools Window Help
@@ @ ‘ Vancouver Ab hd EI'_ @ & @ @ ‘ 5| IE' L_—E‘_,;', ["’E ‘ D ,&F ""'j','é_ M ® ‘ Quick Search
My Library ) | Search Search Whole Library w [[]Match Case [|Match Words
: =
@Configure Sync. Author ¥ Contains - | E]
D) Recently Added 1) |® & Author Year Title Rating Journal Last l]pda... Reference Type =
E_] Unfiled n|e Morley, ... 2018 Environmental §... Frontiersin... 7/10/2563 Journal Article
| 7 Teash M Piippo, A... 5/10/2563
| ® & Behrouz.. 2018 Diagnosisand ma.. W ¥ # % % Clin Med (Lo... 5/10/2563 Journal Article
= My Groups ® & Saposni.. 2011  Diagnosisand ma.. W ¥ Stroke 5/10/2563 Journal Article
| E_] Intracranial Hemorrh... (24) | @ Yang, X... 2017  Criteria for Perfo... J Craniofac 5... 31/8/2563 Journal Article
® BjTraumatic BrainInjury  (17) | @ Mata-M... 2016  Canadian CT head... SpringerPlus ~ 31/8/2563  Journal Article
L Kim, . J... 2011 Imaging for the ... Neurothera.. 31/8/2363 Journal Article| _
=) Find Full Text ® Faul, M.; .. 2007 Using a cost-ben... J Trauma 31/8/2563 Journal Article i
L Li, M.; Si.. 2018  Traumatic Brain L.. J Clin Med 31/8/2563 Journal Article
L Marshall... 2000 Head injury: rece... Neurosurgery 31/8/2563 Journal Article
L Adams, J.. 1989  Diffuse axonal inj... Histopatholo... 31/8/2563 Journal Article
L Werner... 2007  Pathophysiology ... BJA: British J... 31/8/2563 Journal Article
L 2007  Guidelines for th... ® JNeurotrau... 31/8/2563 Journal Article
L Fisher, C.. 1995 Brain herniation: ... Can J MNeurol... 31/8/2563 Journal Article
L Nag, 5.;.. 2009  Pathology and ne... ActaNeurop... 31/8/2563 Journal Article
L Winkler,... 2016  Cerebral Edema ... Neurosurg C... 31/8/2563  Journal Article
L ] Lang, E... 1995 Intracranial press... New Horiz 31/8/2563 Journal Article
[ ] Piyakon... 2014 Challenges Faced... Archives of ... 31/8/2563 Journal Article
[ ] Damklia... 2015 Using an evidenc... MNurse Educ.. 31/8/2563 Journal Article
L Damklia.. 2014  Initial emergenc... Australas Em... 31/8/2563 Journal Article
e Damklia... 2013 Thai emergency ... Australas Em... 31/8/2563 Journal Article
L Long, Br.. 2017  Cerebral Venous ... Emergency.. 31/8/2563 Journal Article
L Kuwaya.. 1994  Dural arterioven... Surg Neurol 31/8/2563  Journal Article
L Halbach,.. 1989  Transvenous em... American Jo.. 31/8/2563 Journal Article
L Newton,.. 1969  Involvement of .. Radiclogy 31/8/2563  Journal Article -
4 M | 3
Showing 42 of 42 references.

@ Layout ~

Referendcedistipanel:shewsihaindiiddum/eaferences stored in

your Endnote library, also known as library records
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Journal term list

 Journal term listis list of journal name in full and abbreviation form

These list are used for making correct journal name in reference

(needed for output style that used journal name in abbreviation form i.e Vancouver)

 Help EndNote works correctly find out the duplicate reference

 Define the journal term list only once but have to be done in every library file

L= | e L= |
- & x - || 5| *
&p Ao @‘ Quick Search 2 = £ Hide Search Panel E_.-‘l- o ®‘ Quick Search C = /A Hide Search Panel
Reference Preview -EE Piippo-2013-Characteristics and long-term @ 4 [ 3 ¥ Reference Preview -EE Piippo-2013-Characteristics and long-term @ 4 [ 3 ¥

1. Piippo 4, Miemeld M, van Popta J, Kangasniemi M, Rinne J, Jddskeldinen JE, et 1.
al. Characteristics and long-term outcome of 251 patients with dural artericvenous
fistulas in a defined population|Journal of neurosurgery|2013;118(5):923-34.

Piippo 4, Miemeld M, van Popta J, Kangasniemi M, Rinne J, Jddskeldinen JE, et
al. Characteristics and long-term outcome of 251 patients with dural arteriovenous
fistulas in a defined population| ) Neurosurg|2013;118(5):923-34.
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Before After
Vancouver v Copy citation W Vancouver ¥ Copy citation v
12 Clarivate 1. Chen X, Liao BY, Cheng L Peng X, Xu X, Li 1. Chen X, Liao BY, Cheng L, Peng X, Xu X, Li
Web of Science” YQ, et al. The microbial coinfection in COVID-19, YQ, et al. The microbial coinfection in COVID-19,
*give full name Applied Microbiology and Biotechnology. Appl Microbiol Biotechnol.|2020;104(18):7777-85.
2020;T04(18):7777-85.
Vancouver Style use the abbreviated journal name
APA 6th v Insert Copy v APA 6th v ‘ Insert ‘ Copy v
Chen, X, Liao, B., Cheng, L., Peng, X., Xu, X, Li, Y., ...
Pub ed Ren, B. 20 icrobial coinfection in
COVID-19.Appl Microbiol Biotechnol,

*give abbreviation name 104(18), 7777 :
doi:10.1007/s00253-020-10814-6

APA Style use the full journal name
Slide 15/30
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Journal term list

p - -
et (e Term Lists s — — ﬁ
@ File Edit References Groups [Tools] Window Help
@@ @ ‘ Vancouver Ab Search Library... Ctrl+F Terms | Lists
| . | r Spell Check Ctrl+Y
My Libra i
vy oy Cite While You Write [CWVW] > [ca M Qeate)iste
All References F
= . Online Search... I Authors Rename List...
& Configure Sync.. s . Rename sty
Il | |keywords =
£DRecently Added 0) Change/Move/Copy Fields... b 2 Delete List...
Bl Unfiled )] !
"L-Ir Trash 0] Syne !
: |
0] T List 3
= My Groups pen Term Lists 1 |
Define Term Lists... Ctrl+4 -
Bl Intracranial Hemorr...  (24) L ;nTe errs == c r|+3 i Delimiters Update List...
sts.., h |
Bl Traumatic BrainInj..  (18) ik e e r+ i O, O:; O- 0O. Oy Oy -
T iE 3 Impaort List...
= Find Full Text [l [ ] custom Delimiter: |
Recover Library... Export List
Find Broken Attachment Links | Carriage return is always used as a term delimiter.
_ f Link Lists...
Library Summary... [l
Subject Bibliography... |
Manuscript Templates... | |
a — —~

1. Tools > Define Term Lists...
2. Inthe Term Lists window, select tab Lists then select Journals

3. Click Import Lists...
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Journal term list

@ Open 50
s i ]
W) U | . « EndMNote X8 » Terms Lists )
Organize = New folder A @
- Favorites i | Anthropology
Bl Desktop _ Archaeology
& Downloads || Astronomy and Astrophysics
i< Recent Places || BioScience
| Chemical
4 Libraries | Economics
3 Documents || Humanities
,J“. Music = || Korean Medical Terms
= Pictures  Law
B Videos | Medical
| Philosophy
1M Cormnputer || Physics
! £, Local Disk (C3) || Religien
a Local Disk (D% _ Zoological Records
I “* Backup Plus (G:)
|
€l Network i
N File name: - ’Textfile (*.bat) v]
4 [ Open |Vl ’ Cancel ]

-

Term Lists q

Terms | Lists

21790 Journals in the Journals List:

< | i |

Full Journal Abbreviation 1 =
A.M.A, Archives of Dermatology ...  AMA Arch. Derm. Syphilol. D
AM.A, Archives of Dermatology AMA Arch. Derm.

AM.A, Archives of General Psyc...  AMA Arch. Gen. Psychiatry

AM. A, Archives of Industrial He...  AMA Arch. Ind. Health

AM.A, Archives of Industrial Hy...  AMA Arch. Ind. Hya. Occup, Med.
A.M. A, Archives of Internal Medi...  AMA Arch. Intern, Med,

AM.A, Archives of Neurology an...  AMA Arch, Neurol, Psychiatry

AM.A, Archives of Neurclogy AMA Arch. Meurol.

AM.A, Archives of Ophthalmology — AMA Arch. Ophthalmal.

AM.A, Archives of Otolaryngology  AMA Arch. Otolaryngol.

A.M.A, Archives of Pathology AMA Arch. Pathol.

A.M.A, Archives of Surgery AMA Arch. Surg.

A.M. A, Journal of Diseases of Ch... AMA J, Dis. Child.

AACN Adwanced Critical Care AACN Adw, Crit, Care

AACN Clinical Issues in Critical Ca...  AACN Clin, Issues Crit. Care Nurs,
AACN Clinical Issues AACN Clin, Issues

AADE Editors' Journal AADE Ed, 1,

AANA Journal AANA T, o

Hint: Hold the Ctrl key to select multiple terms

Edit Term. ..
Delete Term

Insert Term

4. Select the appropriated term lists files (BioScience, Chemical, Medical)
5. Click Terms tab to looking for the journal lists

EndNote : 7simws widosiamusy (24/10/64)

Slide 17/30



@ Mahidol University

./ Faculty of Medicine Ramathibodi Hospital

Outline

* How toinput data

EndNote : 7simws widosiamusy (24/10/64) Slide 18/30



‘@8 Mahidol University

g;,, 2./ Faculty of Medicine Ramathibodi Hospital
TN

How to input data

1. Direct Export from web site

2. Manual typing

3. Online search by using EndNote’s connection

4. Import from PDF file
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1. Direct Export from web site

B Tumors and tumar-like lesions o X +

&« (= & pubmed.nchi.nim.nih.gow/21072731/

National Library of Medicine

National Center for Biotechnology Information

Pl.lbmed.gov tumor

Advanced Clipboard

Search results Save

Review > Semin Musculoskelet Radiol. 2010 Nov;14(5):547-58. doi: 10.1055/5-0030-126807
Epub 2010 Nov 11.

Tumors and tumor-like lesions of peripheral nervi

Klaus Woertler 1

Affiliations + expand
PMID: 21072731 DOIL 10.1055/5-0030-1268073

Abstract

The diagnosis of a peripheral nerve tumer can often be suggested on imaging. Direct continuity with

a neural structure or location along a typical nerve distribution, shape, and intrinsic magnetic
resonance (MR) signal characteristics represent the most important signs in this regard. Although
several nonneoplastic nerve lesions can be specifically diagnosed by MR imaging, benign and
malignant neoplasms of peripheral nerves can usually net be distinguished with confidence. This
article reviews the MR imaging appearance, clinical and pathological features of schwannoma,
localized neurofibroma, plexiform neurofibroma, intraneural perineurioma, fibrolipomatous

Py U S|Pt g [y

EndNote : 7simws widosiamusy (24/10/64)

l=l=]
* = @ :
- I

User Guide PmeengV tumor

1 Advanced Clipboard

B Tumors and tumor-like lesions ¢ X +

&« c & pubmed.ncbi.nlm.nih.gov/21072731/

National Library of Medicine

National Center for Biotechnology Information

Email Send to Display options
Search results

Clipboard

My Bibliography

text §

Collections 3 Create file

Citation manager 2

77 Favorites

Epub 2010 Nov 11.

Klaus Woertler

PAGE NAVIGATION Affiliations + expand

PMID: 21072731 DOIL 10.1055/5-0030-1268073
¢ Title & authors

et Aot - \

Cancel

Review > Semin Musculoskelet Radiol. 2010 Nov;14(5):547-58. doi: 10.1055/5-0030-1268073.

Tumors and tumor-like lesions of peripheral nerves

User Guide

Send to Display options

Create a file for external citation management software

Full text

THIEME CONNECT

vy Favorites
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1. Direct Export from web site

‘ Tumors and tumor-like lesions o X | =+
&« C @& pubmed.ncbinlm.nihgow/21072731/ @ EndNote X8 - [CAT] =l B s
@ File Edit References Groups Tools Window Help Hli"ﬂ
National leraiy of Medicine @@ | Vancouver Ab - El_ @ & @ ':("_;'\ -:_=}| IE‘ ’:—% EE | O ‘%’ ";','1 - ®| Quick Search Q. - £ Hide Search Panel
National Center for Biotechnology Information
My Library | Search Search Whole Group » [[IMatch Case []Match Words Reference Prev ) 4 b =
m E=RAT-P: 142 No References Selected
Author * Contains - +
PUb edgo v fumor |-; Imported References I E]
Advancad Clipboard & Configure Sync... And T JLYear - J| Contains M I B
£D) Recently Added ) | And ~ Title v  Contains - | =
B unfiled w
Search results e =
\if Trash N le @ Author Year Title Rating Journal Last Updated _Re
=- My Groups [ ] Woertler, K. 2010  Tumors and tumor-like lesions of periphera... Semin Musculo... 2/10/2563 Ja
E_!Intracrania\ Hemorr... (24)
Review > Semin Musculoskelet Radiol. 2010 Now;14(5):547-58 B} Traumatic BrainInj... (18)
Epub 2010 Nov 11. || = Find Full Text
Tumors and tumor-like lesions of
Klaus Woertler
Affiliations 4+ expand
PMID: 21072731 DOL 10.1055/5-0030-1268073
Abstract
The diagnosis of a peripheral nerve tumor can often be suggested
a neural structure or location along a typical nerve distribution, sha |
resonance (MR)] signal characteristics represent the most impertant
several nonneoplastic nerve lesions can be specifically diagnosed b
malignant neoplasms of peripheral nerves can usually not be distin
article reviews the MR imaging appearance, clinical and pathologic
localized neurofibroma, plexiform neurcfibroma, intraneural perine
hamartoma, nerve sheath ganglion, traumatic neuroma, malignant a n 5
= - - e Showing 1 of 1 references in Group. (All References: 43) IE‘ Layout ~

#|  pubmed-2107273Lnbib  ~ 4
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1. Direct Export from web site (multiple articles

[=|E] sz =[] =
umor - Search Results - PubMed X | + ‘ B tumor - Search Results - PubMed X | +
> & pubmed.ncbi.nim.nih.gov/?term=tumor W = o : « = C & pubmed.ncbi.nlm.nih.gov/?term=tumor w = ° :

||H National Library of Medicine
National Center for Biotechnology Information

Pl.lb“éd. gov tumor X m Pubmed_ gov tumor X m

National Library of Medicine

National Center for Biotechnology Information

Advanced Create alert Create RSS Clipbeard User Guide Advanced Create alert Create RSS Clipboard User Guide
Save Email Send to Sorted by: Best match | Display options Save Email Send to Sorted by: Best match | Display options
cerALTeR: [ 4,119,708 results 5 items selected | X Clear selection < 4,119,708 Clipboard ted X Clear selection
ey ean . ; ; RESULTS BY YEAR My Bibliography &1 o o f ipheral
ESULTS BY YEAR Tumors and tumor-like lesions of peripheral nerves. P e Ike lesions ol peripnheral nerves.
1 Woertler K. 211y 1 Collections
a . A e P, .
¢ Sy Cite  Semin Musculoskelet Radiol. 2010 Nov;14(5):547-58. doi: 10.1055/s-0030-1268073. Epub 2010 Nov 11. v = Cite I. 2010 Nov;14(5):547-58. doi: 10.1055/s-0030-1268073. Epub 2010 Nov 11.
PMID: 21072731 Review. Citation manager | v. 2
Share i i i imagi i Share t lesi b ifically d d by MR benign and
Although several noenneoplastic nerve lesions can be specifically diagnosed by MR imaging, benign and Ty STIC NETVE [2S10NS CaN be specinically diagnesed by Imaging. benign an
malignant neoplasms of peripheral nerves can usually not be distinguished with confidence. This article malignant neoplasms of peripheral nerves can usually not be distinguished with confidence. This article
O O reviews the MR imaging appearance, clinical and pathological feature ... O O reviews the MR imaging appearance, clinical and pathological feature ...
1785 2021 1785 2021
TEXT AVAILABILIT Cellular Origin, Tumor Progression, and Pathogenic Mechanisms of Cutaneous TEXT AVAILABLIT Cellular Origin, Tumer Progression, and Pathogenic Mechanisms of Cutaneous
2 Neurofibromas Revealed by Mice with Nfl Knockout in Boundary Cap Cells. [ b 2 Neurofibromas Revealed by Mice with Nf1 Knockout in Boundary Cap Cells.
stract . ] p
L[] Abstract cite  Radomska KJ, Coulpier F, Gresset A, Schmitt A, Debbiche A Lemoine S, Wolkenstein P, Vallat JM, Charnay Cite Radomska KJ, Coulpier F, Gresset A Schmitt A, Debbiche A Lemoine 5, Wolkenstein P, Vallat JM, Charnay
[] Free full text P, Topilko . [T Free full text e P, Topilko P.
[ Ful SNare  cancer Discov. 2019 Jan:9(1):130-147. doi: 10.1158/2159-8290.CD-18-0156. Epub 2018 Oct 22. [] Full text =% Cancer Discov. 2019 Jan;9(1):130-147. doi: 10.1158/2159-8290.CD-18-0156. Epub 2018 Oct 22.
Full text PMID: 30348676 Free article.

PMID: 30348676 Free article.

S — Patinmes rmemsime an fna ks RIS allala Ao Secesmme nf ©obisinmn call mcimin callad mesee £l o —.——

o RIFA allaln devanln
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1. Direct Export from web site (multiple articles

- PubMed X -+

ymed.ncbi.nim.nih.gov/Tterm=tumor

al Library of Medicine

Center for Biotechnology Information

ed go Vv tumor

Advanced Create alert Create RSS Clipboard

Save

Create a file for external citation management software

Selection: ‘ Selection (5)
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Characteristics and long-term outcome of 251 patients with
dural arteriovenous fistulas in a defined population
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Object. Management of dural arteriovenous fistulas (DAVFs) has changed during the last decades due to in-
creased knowledge of their pathophysiology and natural history as well as advances in treatment modalities. The
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